Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.
## Contents

What’s New in SAS Environment Manager 2.3 ................................. vii  
Recommended Reading .......................................................... ix  

**Chapter 1 • Introduction to SAS Environment Manager** ............................ 1  
What is SAS Environment Manager? .............................................. 1  
Resource Inventory Model .......................................................... 3  

**Chapter 2 • Finding Your Way Around** .............................................. 7  
Finding Your Way Around ........................................................... 7  
Viewing Important Information at a Glance: the Dashboard ..................... 8  
Monitoring Platforms, Servers, and Services: the Resources Pages .......... 9  
Monitoring Resource Events and Alerts: the Analyze Pages ................... 10  
Performing SAS Tasks: the Administration Page ................................ 12  
Configuring SAS Environment Manager: the Manage Page .................... 13  

**Chapter 3 • Viewing Information at a Glance: Using the Dashboard** .............. 15  
Reading the Dashboard ............................................................... 15  
Customizing Your Dashboard ...................................................... 17  

**Chapter 4 • Finding Resources in Your System** .................................. 19  
Automatically Discovering and Adding SAS Resources .......................... 19  
Using the Auto-Discovery Portlet .................................................. 19  
Performing an Auto-Discovery Scan ............................................. 20  
Rediscovering Resources ......................................................... 20  
Manually Adding a Server .......................................................... 21  
Manually Configuring a Service .................................................. 21  

**Chapter 5 • Monitoring and Controlling Resources** ............................. 23  
Monitoring Resources ................................................................. 23  
Managing SAS Resources ............................................................ 25  
Making Resources Easier to Locate ............................................... 27  
Controlling Resources Using Control Actions .................................... 29  

**Chapter 6 • Working with Events and Alerts** ..................................... 31  
Creating Resource Events ........................................................... 31  
Working with Resource Alerts ..................................................... 33  

**Chapter 7 • Managing Metadata Access** .......................................... 41  
Access Management ................................................................. 41  
Creating an ACT .......................................................................... 42  
Using an ACT ............................................................................. 43  
Updating an ACT ......................................................................... 44  
Reviewing or Adjusting Repository-Level Controls ............................... 45  
Adding an Explicit Grant or Denial ................................................ 45  
Adding a Row-Level Permission Condition ..................................... 46  
Providing Fine-Grained Access Using Permission Conditions ............... 47  

**Chapter 8 • Controlling Access to SAS Environment Manager** ............... 49  
Controlling Access to SAS Environment Manager ................................ 49
What’s New in SAS Environment Manager 2.3

Overview

SAS Environment Manager has the following new features and enhancements:

• The user definition process has been simplified. All users are now created in SAS metadata, rather than in SAS Environment Manager.

• Synchronization between users and subgroups defined in certain groups in metadata and user definitions in SAS Environment Manager has been added.

• The SAS Environment Manager agents now use a new default account for communication with the server.

• Support for creating a new Access Control Template (ACT) has been added.

• Support for metadata clusters has been added.

• Support for managing metadata access has been added.

• A plug-in for managing a SAS Grid Manager grid has been added.

• Support for creating folders and editing the properties of metadata objects has been added.

Managing Metadata Access

Selecting an object in the Administration tab enables you to manage metadata access for that object. The tasks that you can perform include the following:

• creating access control templates (ACTs) (available in the second maintenance release for SAS 9.4)

• updating ACTs

• applying ACTs to metadata objects

• applying explicit controls to objects

• managing repository-level controls

• specifying SELECT permission conditions that give users access to some but not all of the data within a physical table (available in the first maintenance release for SAS 9.4)
Metadata User Synchronization

Users in SAS Environment Manager are now mapped to users created in SAS metadata. During installation, three user groups are created in SAS metadata to contain SAS Environment Manager users. Users and subgroups that are members of these groups are mapped to user definitions in SAS Environment Manager with corresponding roles. A synchronization function has also been added. When users or subgroups are added to one of the supported groups in metadata, the synchronization function creates a corresponding user definition in SAS Environment and assigns the user to the correct role.

Internal Services Account

A new user ID, sasevs@saspw, is now used for communications between the SAS Environment Manager agent and server, to enable plugins to access SAS Metadata Server content, and for batch and other processes to access SAS Environment Manager. The ID is created in metadata and in SAS Environment Manager during installation.

Metadata Object Management

In addition to viewing the properties of metadata objects, some of those properties can now be edited. Properties that can be edited include the following:

- Name
- Description
- Keywords
- Responsible parties
- Extended attributes

Folders to contain metadata objects can also be added, updated, or deleted.
Here is the recommended reading list for this title:

- The online Help for SAS Environment Manager 2.3.
- *SAS Intelligence Platform: Middle-Tier Administration Guide*.
- *SAS Logging: Configuration and Programming Reference*

For a complete list of SAS books, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Book Sales Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
Recommended Reading
Chapter 1
Introduction to SAS Environment Manager

What is SAS Environment Manager?

SAS Environment Manager is a web-based administration solution for a SAS environment. The application can administer, monitor, and manage SAS resources, including administering the SAS Web Application Server and monitoring SAS foundation servers. The application collects and charts data on metrics for monitored resources, providing a comprehensive view of resource health and operation. It also provides functions such as auto-discovery of resources, monitoring of log events, and reporting of alerts. Over the lifecycle of SAS 9.4, functions will be added to extend SAS Environment Manager's capabilities as a centralized administration application for all SAS products.

SAS Environment Manager agents run on all SAS platforms except for z/OS.

SAS Environment Manager is based on VMWare’s Hyperic product, with customizations and plugins to optimize the product specifically for a SAS environment. Some terms and concepts used in SAS Environment Manager are different than in other parts of SAS, but these are noted in this document.

The basic architecture of SAS Environment Manager consists of an agent process running on each platform in a SAS deployment that communicates to a central management server. Agents monitor detected resources and periodically report resource metrics back to the server. The server provides an interface for interacting with those agents, managing the data collected by the agents, distributing plugins, creating alerts and escalation procedures based on collected metrics, and graphing the metrics provided through the installed plugins.
There are five main components to SAS Environment Manager:

agent
An agent is a software process that runs on each platform (middle-tier and server-tier machine) in a SAS deployment. The agent is responsible for tasks such as discovering software components on its platform, gathering metric and availability data for the platform and components, and performing resource control actions. The agents communicate with the management server. Plugins are used to provide the agents with the information needed to discover SAS resources installed on a platform.

management server
The management server is responsible for communicating with the agents. It collects information about items such as discovered resources, metrics, and availability, and issues control actions received from the SAS Environment Manager application. Collected data is stored in the SAS Environment Manager database.

SAS Environment Manager database
The database is a Postgres database that is a repository for all of the information about all of the resources known to SAS Environment Manager. It uses the SAS Web Infrastructure Platform Data Server, which is based on PostgreSQL. After resources are discovered and added to your inventory, the database stores data collected from the agents about the resources.

SAS Environment Manager application
The application is the web-based interface to the SAS Environment Manager system. Resources discovered by the agents and added to the inventory are displayed and monitored. Metric and availability data collected by the agents and stored in the database is displayed and charted. Events and metric data are used to generate alerts. Control actions are sent back through the management server to the agents to control resources on the platforms. The application also includes a framework to add functions specific to SAS, such as server, library, and user administration.
Plugins enable agents to discover and monitor resources in a SAS environment. Each plugin is associated with a specific resource, and provides the agents with the instructions needed to recognize the resource during auto-discovery and to monitor and collect metrics for the resource.

Although open-source plugins are available for VMWare Hyperic, these plugins are not supported by SAS Environment Manager. You should use only plugins provided by SAS.

Resource Inventory Model

Overview

The SAS Environment resource inventory model contains three levels:

platform
A container such as an operating system or a SAS server tier that holds servers and services

server
Software product or process, such as a SAS Metadata Server, that runs on a platform

service
A task-specific software component, such as a SAS logical server, that runs on a server or platform

Platforms

Platforms are the highest level of resource type in SAS Environment Manager. They are containers that host other software and services. There are three major categories of platforms:

- operating system platforms
- SAS Application Server Tier
- Virtual and network platforms

An operating system platform consists of a computer (physical or virtual) and the operating system that runs on it. The SAS Environment Manager uses the system plugin to teach the agent how to auto-discovers the operating system platform. You cannot manually add an operating system platform to inventory. SAS Environment Manager supports most of the operating systems on which SAS is supported.

The SAS Application Server Tier platform is an instantiation of a SAS deployment and a collective store of deployment-wide information such as license information and clustering. Resources in the SAS Application Server Tier platform include SAS Metadata Server and SAS Application Server and their logical servers (such as SAS Workspace Servers, SAS OLAP Servers, and SAS Stored Process Servers). The agent automatically discovers and creates the SAS Application Server through direct communication with the SAS metadata server as a platform resource.

Virtual and network platforms include a variety of platform types that do not map to an individual physical machine running a traditional operating system and are managed by an agent proxy. These include the following:
resources that an agent monitors remotely over the network, such as network hosts and devices
virtual resources such as VMware vSphere hosts and virtual machines
distributed sets of resources, such as GemFire Distributed Systems

The agent does not automatically discover platforms other than the host operating system and the SAS Application Server Tier. You must manually create other platforms or supply resource properties data that enable the agent to manage them. Below are the virtual and network platform types that SAS Environment Manager supports:

- Cisco IOS
- GemFire Distributed System
- Network Device
- Network Host
- VMware vSphere Host
- VMware vSphere VM

**Servers**

In SAS Environment Manager, a server is commonly a software product or process that runs on a platform. Servers provide a communication interface and perform specific tasks upon request. The Monitoring Defaults page on the Manage tab lists all of the server types (along with platform and service types) that SAS Environment Manager supports.

Most server types are auto-discovered by a server type-specific SAS Environment Manager plugin. If the plugin that manages a server does not support auto-discovery, or if auto-discovery of a server fails, you might need to manually create a server. See “Manually Adding a Server” on page 21.

Examples of server types include the following:

- SAS Metadata Server
- SAS Object Spawner
- Postgres server
- SAS Home Directory Service

**Services**

In SAS Environment Manager, a service is a software component dedicated to a particular task that runs on a server or platform. A service that runs on a server is a service, and a service that runs on a platform is a platform service.

The resource plugin that discovers a platform or server also discovers key services, such as CPUs, network interfaces, and file systems that are running on the platform.

You can also configure a platform service that serves as a proxy for a resource that the SAS Environment Manager agent can monitor over the network. Examples include

- DNS service
- POP3 service
- Fileserver mount
• Windows service
• Network host storage

For more information, see “Manually Configuring a Service” on page 21.

Services that run on a server can be either an internal component of the server or a deployed item. Logical SAS servers are considered to be services that run on SAS server resources. Examples of services that run on servers include the following:

• PostgreSQL database
• SAS Object Spawner
• SAS Logical Workspace Server
• SpringSource tc Runtime Cache

The Monitoring Defaults page on the Manage tab lists the supported platform service types (along with platform types and server types) provided by the installed plugins.
Chapter 2
Finding Your Way Around

Finding Your Way Around

The SAS Environment Manager interface is organized around five main areas, as illustrated in this figure:

The following table describes the main functional areas of SAS Environment Manager:

<table>
<thead>
<tr>
<th>Main Page</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Configurable collections of portlets; this is the initial view when starting SAS Environment Manager.</td>
</tr>
<tr>
<td>Resources</td>
<td>Resource-level monitoring and management.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Deployment-wide views of events and alerts.</td>
</tr>
<tr>
<td>Administration</td>
<td>Metadata folders, basic properties of metadata objects, security and access controls</td>
</tr>
</tbody>
</table>
### Viewing Important Information at a Glance: the Dashboard

The Dashboard is the starting point when you sign in to SAS Environment Manager. The page consists of a collection of views (called portlets) of resources and metrics that are the most important to your environment. The Dashboard is customizable, so you can specify how many portlets are displayed, which metrics and functions they present, and which resources they cover. For example, your Dashboard could contain a portlet to display recently auto-discovered resources, a portlet to display recent alerts, or a portlet to display the availability of a group of selected servers. Selecting an entry (such as a resource or an alert) in a portlet takes you to detailed information about the entry.

Each user can access their own personal Dashboard as well as a Dashboard for each of the native roles of which the user is a member. Each Dashboard can be customized to meet the needs of the user or role.

An example Dashboard page is displayed in this figure.

---

**Figure 2.1  Example Dashboard**

---
Monitoring Platforms, Servers, and Services: the Resources Pages

Use the Resources pages to monitor, configure, and manage inventory resources. The main Resources page lists the inventory of resources, organized by type:

- Platforms
- Servers
- Services
- Compatible Groups/Clusters
- Mixed Groups
- Applications

Other selections under Resources enable you to view only resources that are currently down or to select from recently viewed resources. This figure shows a server resource list.

Figure 2.2 Resource List

The icons on the left of the resource name enable you to quickly jump to the Monitor, Inventory, or Alerts page for the resource. Selecting the resource name displays the Monitor page for the resource. A lock icon indicates that, because of your permissions, a particular feature is not available for a particular resource.

Use these strategies to locate resources on the Resources page:

- Only one inventory type is displayed at a time. To access resources of a different inventory type, click a link in the table header.
• To further limit the display, you can specify criteria in the **Search** row and then click (at the end of the **Search** row). Not all criteria are supported for all inventory types.

• To include only resources that you own, select the **Owned by** check box.

• There might be multiple pages of resources in the list. Use the controls below the list to navigate.

• You can use **Resources ⇒ Recently Viewed ⇒ the page name** to quickly return to a page that you recently viewed.

• As an alternative to browsing and filtering on the **Resources** page, you can use the search field (on the right side of the application banner) to quickly locate a resource by its name.

• To view a list of resources that are not currently available, select **Resources ⇒ Currently Down**.

• You can initiate resource management tasks from the **Resources** page.

---

**Monitoring Resource Events and Alerts: the Analyze Pages**

**Overview**

The **Analyze** pages contain the Alert Center, the Event Center, and the Operations Center. These pages enable you to quickly view and work with alerts and events throughout your system.

An event is any sort of activity in a resource that you are monitoring. Alerts are a user-defined type of event that acknowledges a critical condition in a selected resource. You can configure SAS Environment Manager to also log events for log messages and resource configuration changes.

**Alert Center**

The Alert Center page provides a deployment-wide view of alerts and alert definitions.

The default view of the Alert Center is the **Alerts** tab, which displays a table with information about currently active alerts. You can use the filter controls to filter by criteria such as status, type, and priority. Clicking on an entry in the **Alert Definition** column in the table displays detailed information about the alert.
Although you can select the check box next to an alert and click **Fixed** to identify the problem as having been corrected, the Detail page for the alert enables you to not only mark the alert as fixed, but also to enter information about the resolution of the alert.

The **Definition** tab in the Alert Center contains a table listing all of the defined alerts. Clicking on an alert takes you to the definition page for the alert, where you can view more detailed information or edit the alert.
Event Center

The Event Center page provides a deployment-wide view of all events that have been logged for resources. Alerts are automatically logged as events. You can configure SAS Environment Manager to also log events for log messages, resource configuration changes, and resource metric triggers.

To access the event center, select Analyze → Event Center.

Operations Center

The Operations Center lists resources that are down or have unfixed alerts. You can use filters to find resources and problem types of interest. This concise view displays the current number of unavailable resources and unfixed alerts, and a one line problem summary for each resource.

Performing SAS Tasks: the Administration Page

The Administration page enables you to access and manage folders and folder contents in the SAS Metadata server. After you select a folder or an object contained in a folder, you can perform these tasks:

- view details about the folder or object’s metadata
- modify the name, description, keywords, responsible parties, and extended attributes for folders and objects
- manage metadata access (such as access control templates and permissions)
- create, update, and delete folders
Configuring SAS Environment Manager: the Manage Page

Overview

Use the pages under Manage to control how the SAS Environment Manager application works.

Authentication/Authorization

The Authentication/Authorization area enables you to manage SAS Environment Manager users and user roles. These users and roles are not the same as the users and roles in SAS metadata that control access to SAS metadata objects, although SAS Environment Manager users are synchronized with users that are defined in metadata and added to specific groups. Use the Administration tab to control authorization for metadata objects.

In order to distinguish between the SAS Environment Manager access features and those in SAS metadata, this document and the SAS Environment Manager online Help refers to features internal to SAS Environment Manager as native features (such as native users or native roles). However, the SAS Environment Manager interface does not use the native terminology.

Server Settings

The Server Settings area enable you to change the settings for the SAS Environment Manager server, the defaults for monitoring, the configuration of escalation schemes, and the SAS Environment Manager plugins.

Server Settings

contains settings for the SAS Environment Manager server, including global alert properties, e-mail configuration, and notification properties

Monitoring Defaults

contains default monitoring and alerting definitions for all types of platforms, platform services, and servers supported by SAS Environment Manager.

Escalation Schemes Configuration

enables you to define notification or logging actions that are taken for alerts.

Plugin Manager

lists all currently loaded plugins and enables you to delete and update existing plugins, and load new ones. Deleting or updating a plugin cannot be reversed. Always save a copy before deleting or updating a plugin. You can find additional plugins for SAS Environment Manager at the Enterprise Management Integration area of SAS Customer Support on the web (support.sas.com/rnd/emi).

Plugins

The Plugins area contains functions that are added to the base functionality of SAS Environment Manager to perform a specific action. Plugins include the following:
License Usage Status

The **Licenses Usage Status** area displays the number of licenses in use on the platform as well as the total number of licenses allowed.
Chapter 3
Viewing Information at a Glance:
Using the Dashboard

Reading the Dashboard

The Dashboard is your first view every time you start SAS Environment Manager. It is an at-a-glance view of the things that are most important to you when administering your environment, such as favorite resources, recent alerts, and resources that are currently experiencing problems.

The page contains a collection of portlets that provide information at a glance for a measure or a type of resource. You can select which portlets appear on the Dashboard, so the Dashboard shows you the information you most need to see. Selecting an entry in a portlet takes you to more detailed information about the entry. For example, selecting an entry in the Recent Alerts portlet takes you to the Alert Detail page for that alert. The following figure illustrates a sample Dashboard portlet.

Figure 3.1  Sample Portlet

<table>
<thead>
<tr>
<th>Availability Summary</th>
<th>Physical (03) Components</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource Type</strong></td>
<td><strong>Availability</strong></td>
</tr>
<tr>
<td>FileSystem Mount</td>
<td>☑ 6</td>
</tr>
<tr>
<td>Linux</td>
<td>☑ 2</td>
</tr>
</tbody>
</table>

The Dashboard is divided into two columns, and the portlets that can appear differ between the left and the right column. Some portlets can appear only once on a Dashboard, whereas other portlets can appear more than once. The portlets that can appear more than once are ones that display information about a selected group of resources. Each instance of the portlet displays information about different resources. The portlets that can appear only once display information for the entire environment.

This table lists the portlets that you can choose to appear on a Dashboard, as well as where they can appear and how many instances are allowed.

Customizing Your Dashboard
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Location</th>
<th>Instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Discovery</td>
<td>Lists new and changed resources and enables you to add them to the inventory. Check this portlet after you install a plugin to accept the newly discovered resources into the inventory.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Availability Summary</td>
<td>Indicates the availability of selected resources, grouped by resource type. This portlet refreshes every minute.</td>
<td>Left</td>
<td>Multiple</td>
</tr>
<tr>
<td>Control Actions</td>
<td>Lists recently performed actions on managed resources and upcoming scheduled actions. Also indicates which quick control actions are most frequently performed.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Favorite Resources</td>
<td>Lists selected resources.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Saved Charts</td>
<td>Displays selected charts as a slide show.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Recent Alerts</td>
<td>Lists the most recently triggered alerts for selected resources. This portlet refreshes every minute.</td>
<td>Right</td>
<td>Multiple</td>
</tr>
<tr>
<td>Recently Added</td>
<td>Lists platforms that have been recently added to inventory.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Search Resources</td>
<td>Enables you to search for resources. The search supports case-insensitive, partial-term queries for a specified inventory type.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Summary Counts</td>
<td>Displays a count of managed resources by inventory type. Only those resources that you are allowed to access are displayed.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Group Alerts Summary</td>
<td>Displays traffic light indicators for resource alerts and group alerts for selected groups. To view a list of alerts that have fired for a group, click that group’s traffic light. To view a group page, click that group’s name.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Metric Viewer</td>
<td>Displays selected metrics for selected resources. This portlet refreshes every minute.</td>
<td>Right</td>
<td>Multiple</td>
</tr>
</tbody>
</table>
Because the Dashboard page can be customized, each user has access to multiple Dashboards, with each one modified according to different needs. Each user has access to a personal Dashboard, which contains portlets selected by the user. In addition, each user can also access a Dashboard for each of the native roles of which the user is a member. Each of those Dashboards is customized with the portlets that are most useful for that role. To choose a different Dashboard, select the one that you want to use from the Select a Dashboard field.

A new Dashboard type is automatically created whenever you create a new native role.

## Customizing Your Dashboard

You can customize any Dashboard to which you have access by selecting portlets to appear on your Dashboard and by selecting the information that is displayed in each portlet.

To add a portlet to your Dashboard, use the Add content to this column menu to select from the available portlets and then click the Add icon, which is beside the field. The portlets displayed in the list depend on whether you are adding a portlet to the right or left column and which portlets have already been added to the Dashboard.

After the portlet is placed on your Dashboard, you can click and drag the portlet header to move it to a different location. However, you cannot move a portlet from one column to another.

To change the information that a portlet displays, click on the configuration icon in the portlet’s header. Use the Portlet Configuration page to select options that narrow the focus of the information displayed in the portlet. The options available are unique to each portlet. Examples include the following:

- how many of the most recent control actions are displayed (Control Actions portlet)
- the number and type of alerts issued for selected resources (Alerts portlet)
- specified resources (Availability Summary portlet)
You can use groups (compatible groups, mixed groups, and application groups) to make your Dashboard portlets more useful. Groups enable you to organize resources by type or function within your organization. You can then configure portlets to display information about resources in particular groups, so your Dashboard contains information about the resources that are most vital to you.

To remove a portlet from the Dashboard, click on the delete icon for the portlet.
Chapter 4
Finding Resources in Your System

Automatically Discovering and Adding SAS Resources

When the SAS Deployment Wizard installs SAS applications, it creates a file called auto-approved.properties. This file is located in the `<agenthome>/conf` directory.

This file lists all of the resource types that are automatically monitored after they have been discovered. When you run SAS Environment Manager for the first time, the application auto-discovers and auto-accepts the resources listed in the auto-approved.properties file. All of the resources in your initial SAS installation are automatically in your inventory when you start using SAS Environment Manager. Resource types that are not listed in this file must be accepted for monitoring after they have been discovered.

Using the Auto-Discovery Portlet

The Auto-Discovery portlet displays a list of servers and platform services that are auto-discovered but not auto-accepted. All SAS resources should be auto-discovered and auto-accepted, so they will not appear in this portlet. Resources that are listed on the portlet are known but are not yet being monitored. After the resources from the initial SAS installation have been discovered and added to the inventory, the Auto-Discovery portlet lists new resources from custom plug-ins that have been added to the monitored platforms.

To discover and add resources, follow these steps:

1. On the Dashboard, check the Auto-Discovery portlet to see whether new resources are listed.
2. Select the check box beside the resources that you want to monitor and select Add to Inventory.

3. Go to the Resources page. The resources you just added are listed in the appropriate table, together with any resources that are already being monitored. However, an Unknown icon ( fileSize ) is displayed in the Availability column for the new resources, because SAS Environment Manager has not begun to collect monitoring data. SAS Environment Manager collects data at intervals rather than continuously, so you must wait for the next data-collection cycle.

4. After approximately five minutes, data should be collected for the new resources and the Availability column reflects the status of the resources.

If the status of a new resource is displayed as Unknown even after a period of waiting, then the resource might not be completely configured for data collection. To configure the resource, follow these steps:

1. In the Resource page, locate the resource whose status is unknown and click on the entry in the Resources table. The Monitor page for the selected resource is displayed.

2. A message is displayed if the resource needs to be configured. If you need to perform additional configuration steps, select Inventory to display configuration details for the resource.

3. Scroll to the Configuration Properties area of the page and verify that the properties are correct. Click Edit to make changes to the properties.

### Performing an Auto-Discovery Scan

If you know that resources have been added on a platform that you are monitoring, you can run an auto-discovery scan on the platform to locate the resources. Once the resources have been discovered, you can add them to your inventory for monitoring.

To perform an auto-discovery scan of a platform, follow these steps.

1. Using the Resources tab, go to the Detail page for the platform that you want to scan.

2. Select Tools Menu => New Auto-Discovery

3. If you want to scan for all servers and system processes on the platform, click OK.

4. If you want to scan for specific server types, select the check boxes for the server types that you want to scan for. You can also select attributes such as directories to include or exclude from the scan and the depth at which to scan. When you have specified the scanning criteria, click OK to start the scan.

### Rediscovering Resources

After resources have been auto-discovered, there might be some resources that cannot be added to the inventory for some reason. If this happens, you can clear the contents of the auto-discovery queue and try discovering them again. After the resources are removed from the queue, and you restart the agent, the agent will rediscover the resources.
To clear the auto-discovery queue follow these steps:

1. Select Manage ⇒ HQ Health to display the HQ Health page.
2. On the HQ Health page, select the Database tab.
3. In the Action field, select Purge AIQ Data and click ▶.

You can also manually delete any server resources from the Resources page. The servers are then rediscovered when you run an auto-discovery scan.

---

**Manually Adding a Server**

There might be some instances where you need to monitor a server that is not auto-discovered by the SAS Environment Manager agent. To manually add a server, follow these steps:

1. Navigate to the Resource Detail page for the platform on which the server runs.
2. Select Tools Menu ⇒ New Server to display the New Server page.
3. On the New Server page, specify the server name.
4. Use the Server Type menu to select the type of server. If the server type that you want to add is not listed, it is not supported by SAS Environment Manager and cannot be added.
5. In the Install Path field, specify the full pathname to the server software.
6. Click OK to complete the server definition.

*Note:* Because the agent does not update data continuously, it might take several minutes before metric data begins appearing for the new server.

---

**Manually Configuring a Service**

There might be some instances where you need to monitor a service that is not auto-discovered by the SAS Environment Manager agent. To manually add a service, follow these steps:

1. In the Resources view, select the platform that contains the service that you want to monitor.
2. In the Detail view for the selected platform, select Tools Menu ⇒ New Platform Service.
3. Specify a name for the service and select the service type. Common selections include HTTP, Fileserver File, and TCP.
4. Click OK to create the service and display the service details. Select the Configuration Properties link on the page.
5. Use the instructions on the Configuration Properties page to specify the options needed to monitor the service.
Chapter 5
Monitoring and Controlling Resources

A central capability of SAS Environment Manager is the ability to monitor resources. Monitoring enables you to track a resource’s availability and overall health. A variety of metric data is displayed, both in numeric and graphic format, to enable you to examine detailed information about the resource’s operation.

To view the monitoring information for a resource, select a resource from the table on the Resources page.
The fastest way to check the status of the selected resource is to use the availability bar, which is above the indicator charts. The availability bar displays a color-coded dot that represents the availability during a time slice. The length of each time slice depends on the display range that you select (for example, if you display the past eight hours of data, each dot corresponds to approximately eight minutes). The percentage of time that the resource was available is displayed at the end of the availability bar.

The dots are color-coded using the following format:

- **Green**: 100% availability
- **Yellow**: Partial availability; between 0% and 100%
- **Red**: 0% availability

An availability bar such as the one in the following figure shows that the resource fluctuated between being available, partially available, and unavailable over the most recent time slices.

To help determine the cause of availability problems, click on the dot for a particular time slice. The selected time slice is highlighted on the indicator charts below the availability bar. This function helps you quickly check the charts for data that might correspond to the availability problem.
To change the metrics that are displayed in the metric charts, use the menu on the left side of the page to select either **All Metrics** or **Problem Metrics**, and then click **View Metrics** to display a list of available metrics. Click the arrow beside a metric to add the chart to those displayed on the page.

The events bar is displayed below the indicator charts. It is similar to the availability bar, with dots representing time slices. The bar displays only a red dot if an event occurs during a time slice. If no event occurs, the bar remains black.

---

### Managing SAS Resources

#### SAS Server Names

Because SAS Environment Manager is based on VMWare’s Hyperic, some server names in SAS Environment Manager do not match the names that are used in a SAS deployment. Use this table to determine the name of the server that you are interested in.

<table>
<thead>
<tr>
<th>SAS Server Name</th>
<th>Server Name Displayed in SAS Environment Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Environment Manager</td>
<td>Apache Tomcat 5.5, 6.0, 7.0</td>
</tr>
<tr>
<td>SAS Environment Manager Agent</td>
<td>HQ Agent</td>
</tr>
<tr>
<td>SAS Web Server</td>
<td>vFabric Web Server 5.1, 5.2</td>
</tr>
</tbody>
</table>
Using the Map Control

The Map control provides a visual representation of resources and the next level of parent and child resources. You can click on any of the resources listed on the map to go to the Monitor page for that resource. The Map control is available on the Monitor page for a resource.

The map for a platform displays the servers under the platform, and the map for a server displays the services under the server. You can use the map to better understand how a SAS environment is presented in SAS Environment Manager.

In SAS Environment Manager, the SAS Application Server Tier is considered to be a platform. The map for the platform illustrates the SAS servers that are part of the server tier.

Logical SAS servers, such as logical workspace servers or logical stored process servers, are treated in SAS Environment Manager as services, so they are displayed as children under the SASApp server.

For a SAS Object Spawner, the services listed in the map are the servers that are spawned by the spawner.
Making Resources Easier to Locate

Organizing Resources into Groups

In SAS Environment Manager, resources are organized into groups to make them easier to locate and manage. There are six different types of groups:

- platform resource groups
- server resource groups
- service resource groups
- compatible groups
- mixed groups
- applications

These groups are automatically created. When resources are discovered and then added to the inventory of monitored resources, they are added to the appropriate resource group. The three resource groups that are automatically created in SAS Environment Manager are platforms, servers, and services. It is important to note how SAS resources map to the resource hierarchy. For example, logical SAS servers are added to the services group.

Compatible groups

These groups contain selected instances of a single type of resource (for example, SAS Object Spawners). Creating a compatible group enables you to view aggregate metrics for a resource type. Compatible groups also make it easier for you to locate resources that you need to monitor. For example, you can create a group containing several servers of critical importance, which prevents you from having to search for those servers among the large numbers that might be on your site. After you create a
compatible group, you can add resources to the group if they match the selected group type.

mixed groups
These groups are user-created groups that can contain multiple types of resources. Mixed groups can contain other groups, platforms, servers, and services, or applications. Availability is the only metric that is available for a mixed group. This type of group is useful for functions such as checking the availability of a SAS Object Spawner and all of the spawned services or for viewing the collective availability of a group of resources.

application
These groups are a set of selected services, usually running in different servers on multiple platforms, that together fulfill a single business purpose. Creating application groups enables you to manage your infrastructure from an application perspective, as opposed to a hardware perspective.

Creating a Group
To create and populate a group, follow these steps:
1. In the Resources page, select Tools Menu ⇒ New Group.
2. In the New Group page, specify a name for the group.
3. Use the Contains Resources menu to select the type of group that you want to create.
4. Use the Select Resource Type menu to select the type of resource the group will contain.
5. Click OK to create the group.
6. In the Resources page, click on a resource that you want to add to the group.
7. In the Details page for the selected resource, select Tools Menu ⇒ Add To Group.
8. In the Group Manager page, select the group to which you want to add the resource. If the group that you want to add the resource to is not listed, the selected resource type is not the same as the resource types specified for the group.

Creating an Application
To create and populate an application, follow these steps:
1. In the Resources page, select Tools Menu ⇒ New Application
2. In the New Application page, specify a name for the application. Click OK to create the application.
3. The Configuration page for the application appears. In the Services area, click Add to List to select resources for the application.
4. In the Services List, select the services in the Services list that you want to add to the application and use the arrow button to move them to the Add Services list. Click OK when you finish selecting services, and then click OK again to create the application.
Controlling Resources Using Control Actions

What is a Control Action?

Control actions enable you to control certain types of servers and services from SAS Environment Manager. You can create control actions to perform operations such as starting, stopping, restarting, pausing, and resuming a server or starting, stopping and sending messages through a service. The specific actions available depend on the server or service type selected. You can define resource actions to run immediately, to run on a schedule, or to run in response to an alert.

You can use control actions to control these types of servers:

• PostgreSQL SAS Web Infrastructure Platform Data Server (PostgreSQL 9.x)
• SAS Object Spawner
• SAS OLAP Server
• SAS Metadata Server
• SAS Web Application Server (SpringSource tc Runtime)

Performing Immediate Resource Control Actions

To use a control action to perform an immediate action on a resource, follow these steps:

1. In the Resource Details page for the selected server or service, click Control. If this menu item is not present, the resource does not support control actions. The Control Action page is displayed.

2. In the Quick Control area, select the type of action that you want to perform in the Control Action field.

3. Specify any arguments for the action in the Control Arguments field.

4. Click to perform the action.

Scheduling Resource Control Actions

To create a scheduled resource control action, follow these steps:

1. In the Resource Details page for the selected resource, click Control. If this menu item is not present, the resource does not support control actions. The Control Action page is displayed.
2. In the Control Action Schedule area, click New. The Scheduled Control Action page is displayed.

3. Select the action that you want to perform in the Control Action field.

4. In the Schedule area, select the radio button next to the date and specify the date and time that the scheduled action should take place.

5. Specify how often the action should recur and when the scheduled recurrence should end.

6. Click OK to save the scheduled control action.

To view the list of scheduled control actions for the resource, click Control in the Resource Details page for the selected resource. All scheduled control actions are listed in the Control Action Schedule area.

Performing Server Actions in Response to an Alert

To define a control action to occur in response to an alert, follow these steps:

1. Create or edit an alert definition. See “Defining an Alert” on page 34 for more information. On the Alert Definition page, click Control Action, then click Edit. The Add Control Action page is displayed.

2. Use the Resource Type field to select the type of server or service for which you want to create the control action.

3. After you select the resource type, the Resource Name field is populated with all instances of the selected resource type. Select the instance for which you want to create the control action.

4. Select the type of action to be performed in the Control Type field. The field contains only actions that are supported on the selected resource type.

5. Click OK to define the control action. The defined action will now take place whenever the associated alert occurs.
Chapter 6

Working with Events and Alerts

Creating Resource Events

Overview of Events

SAS Environment Manager provides the capability to monitor metrics, scan log files, manage configuration changes, and monitor availability. When there is a change in a resource’s threshold value for one of these items, an event is recorded in SAS Environment Manager’s event message system. Events are also automatically created for certain types of entries in SAS server logs, and you can specify other criteria that will create events based on SAS server logs. All events throughout the entire deployment are displayed in the Event Center. To access the Event Center, select Analyze ⇒ Event Center.
The table shows information about recently recorded events, including the status, the resource involved, and information about what caused the event to be triggered. You can subset the table to locate events more quickly. For example, you can show only the events that have at least Error status, or only the ones that affect resources in a specified group.

Clicking on the name of the resource in the event table takes you to the resource’s Detail page.

**Creating Events Based on SAS Server Logs**

SAS Environment Manager monitors the log files for SAS servers and automatically creates events for error messages recorded in those logs. These logs use the standard logging facilities of SAS. For more information, see *SAS Logging: Configuration and Programming Reference*. The events are added to the rest of the events recorded by SAS Environment Manager.

The types of SAS servers whose logs are used to create events are as follows:

- SAS Metadata Server
- OLAP server
- Object spawner
- Stored process server
- CONNECT spawner
- Workspace server
- Pooled workspace server

You can also change the configuration to look for specific types of SAS server log entries in addition to errors. The file `sev_logtracker_plugin.properties` contains entries for each type of SAS server log entry that SAS Environment Manager looks for. You can add to this file to create events for criteria of your choosing. Each SAS server has its own properties file, so logging events can be created for specific server types.

For example, all `sev_logtracker_plugin.properties` files contain these entries by default:

```plaintext
# All fatal
level.fatal.1=.*
```
# All errors
level.error.1=*.*
#
# User lockout warnings
level.warn.1=.*Access to this account.*is locked out.*

The entries in this file use the format
level.[level_of_message].[sequential_number]=[regular_expression]

level.fatal.1=.* specifies that an event is created whenever a message appears in the SAS log with a level of Fatal. The message can contain any text. The second entry produces the same result for Error messages.

level.warn.1=.*Access to this account.*is locked out.* specifies that an event is created whenever a message with a level of Warn appears that also contains the text Access to this account.*is locked out.

To add your own entries to the properties file in order to create events for specific messages, follow these steps:

1. Edit the file <server_config_directory>/sev_logtracker_plugin.properties (for example, /opt/SAS/Lev1/SASApp/OLAPServer/sev_logtracker_plugin.properties)
2. Add a line for the message that you want to track. The format is
level.[level_of_message].[sequential_number]=[regular_expression]
For example, this entry looks for an INFO message containing the phrase “AUTOEXEC processing beginning”:
level.info.1=.*AUTOEXEC processing beginning.*

3. If you add multiple entries to look for messages at the same log level, increment the number. For example,
level.info.2=.*Message text here.*

4. Save the file. SAS Environment Manager automatically uses the revised file.

---

**Working with Resource Alerts**

**Overview of Alerts**

If you want to identify a type of event for notification or further action, you can create an alert. Alerts are a user-defined type of event that indicates a critical condition in a selected resource. When an alert occurs, it must be acknowledged, and alerts are listed until they are marked as being fixed. You can define escalation schemes to identify the actions that happen if an alert is not fixed within a specified time.

Alerts are logged by the agents and all events throughout the entire deployment are displayed in the Alert Center. To access the Alert Center, select **Analyze ➪ Event Center**.
You can filter the alerts, for example, so that only the most recent ones or the ones of a specified type are displayed. Click the icon to acknowledge an alert. Select the check box next to an alert, and then click **Fixed** to fix the alert. You can also click on the entry in the **Alert Definition** column to display the **Alert Details** page, where you can view details about the alert and mark the alert as fixed (with comments).

---

**Defining an Alert**

To define an alert, follow these steps:
1. Select Resources ⇒ Browse or use a dashboard portlet to locate the resource for which you want to create an alert.

2. There are three icons on the left of the entry for the resource in the table. Click on the alert icon, which is on the right of the group. The Alerts page for the resource appears.

3. Click New to display the New Alert page.

4. In the Alert Properties area, specify the name and priority for the alert and whether it is active.

5. In the Condition Set area, specify the conditions that must be met in order for the alert to be triggered. You can specify up to three conditions for each alert. Use these fields to specify the condition that triggers the alert Metric:

   - Metric specifies that the alert is triggered based on the value of a metric that is monitored for the resource. You can specify that the condition is based on comparison to a fixed value, a percentage of a value, or a change in value. If you want to create an alert for a metric that is not listed, you must first enable collection of that metric.

   Update the metric collection settings for the resource type (choose Monitoring Defaults from the Manage page) or for the specific resource (click Metrics on the resource’s Monitor page).
Inventory Property
specifies that the alert is triggered based on a change in the value of a resource property (such as version number). This condition is available only for certain types of resources (such as platforms and SAS Metadata Servers).

Control Action
specifies that the alert is triggered when an action meets a specified condition (such as the action of stopping a failed server). This condition is available only for servers that can be controlled through control actions. See “Controlling Resources Using Control Actions” on page 29 for more information.

Events/Logs Level
specifies that the alert is triggered when a selected type of log entry (such as Error) and an optional accompanying text string appears in the log.

If you are defining an alert based on events from SAS server logs, the available values in this field do not match the logging levels available in SAS server logs. The four SAS Environment Manager levels must match the six levels in SAS server logs. Selecting Error in this field matches both the Fatal and Error levels in SAS server logs. Selecting Debug in this field matches both the Trace and Debug levels in SAS server logs.

Config changed
specifies that the alert is triggered when a configuration file changes (you can choose to specify the name of the configuration file).

6. In the Enable Action field, specify whether the alert is triggered only once, or periodically as long as the alert condition persists.

7. Click OK to define the alert and display the Alert Configuration page.

8. On the Alert Configuration page, you can specify an escalation scheme and identify the users and roles that should be notified when the alert occurs. To create an escalation scheme, see “Defining an Escalation Scheme” on page 36.

9. Click Return to Alert Definitions when you are finished.

Defining an Escalation Scheme

An escalation scheme is a series of actions that take place when an alert is not acknowledged or fixed within a certain period of time. An escalation scheme can be applied to multiple alerts. You can define an escalation scheme to perform any of these actions:

- send an e-mail or SMS message
- make an entry in a system log
- issue an SNMP notification

To define an escalation scheme, select Manage ➔ Escalation Schemes Configuration (in the Server Settings area).
For information about the information required when defining an escalation scheme, refer to the Help for the page.

**Example: Defining an Alert for SAS Work Directory Space**

This example provides information for setting up an alert to be triggered whenever the SAS Work directory reaches 90% of its capacity. The alert should be issued once every two hours until the condition is cleared. When the alert is triggered, users with the Operations role should be notified.

1. Locate the service **SAS Home Directory 9.4 SAS work directory**. The service is under the **SAS Home Directory 9.4** server.
2. Navigate to the Resource Detail page for the service. On the Detail page, select **Alert** ⇒ **Configure** to display the Alert Configuration page. Click **New** to display the New Alert Configuration page.
3. Name the alert, select the priority, and specify that the alert should be active.
4. In the **If Condition** area, select the **Metric** radio button, then select **Use Percent** in the **Metric** field.
5. To specify 90% capacity, enter .9 in the **absolute value** field. To specify that the alert is triggered whenever the used capacity exceeds 90%, specify and select **> (Greater than)** from the comparison menu.
6. In the **Enable Action(s)** field, specify 1 for the number of times the alert is issued, 2 for the timer period, and select **hours** for the time period units. These values specify that the alert is issued one time every two hours while the alert conditions are met.

7. Click **OK** to define the alert and display the Configuration page for the new alert.

8. Select **Notify Roles**, and then select **Add to List**.

9. Select the check box beside **Operations** in the **Roles** list and use the arrow control to move the role to the **Add Role Notification** list.

10. Click **OK** to close the Role Selection page and then Return to Alert Definitions to complete the process of defining the alert.

### Example: Defining an Alert for a SAS Server Log File

This example provides information for setting up an alert to be triggered whenever a warning message for the I/O Subsystem appears in the log of the SAS Metadata Server. The alert should be issued every time an error appears in the log.

1. Follow the procedure in “Creating Events Based on SAS Server Logs” on page 32 to create an event from the SAS Metadata Server log file. Add the entry

   \[
   \text{level.warn.2} = \text{*I/O Subsystem.*}
   \]

   to the `sev_logtracker_plugin.properties` file for the SAS Metadata Server.


3. Navigate to the Resource Detail page for the server. On the Detail page, select **Alert** → **Configure** to display the Alert Configuration page. Click **New** to display the New Alert Configuration page.

4. Name the alert, select the priority, and specify that the alert should be active.

5. In the **If Condition** area, select the **Event/Logs Level** radio button, then select **Warn** in the **Event/Logs Level** field.

   In the **match substring** field, enter **I/O Subsystem**. These values specify that an alert is issued whenever an event is found for a Warn message from the log containing the string “I/O Subsystem.”

6. In the **Enable Action(s)** area, select the **Each time conditions are met** radio button. This specifies that the alert is triggered each time an I/O Subsystem warning appears in the log.

7. Click **OK** to define the alert.
**Example: Defining an Alert for Available Memory**

This example provides information for setting up an alert to be triggered whenever the free memory on a SAS Web Application Server falls below 90% of 1.3 GB. The alert should be issued once every fifteen minutes until the condition is cleared.

1. Locate the server in the Resource page. The Resources page lists SAS Web Application Server using the server type SpringSource tc Runtime.

2. Navigate to the Resource Detail page for the server. On the Detail page, select Alert Configure to display the Alert Configuration page. Click New to display the New Alert Configuration page.

3. Name the alert, select the priority, and specify that the alert should be active.

4. In the If Condition area, select the Metric radio button, then select Heap Memory Free in the Metric field.

5. To specify the memory condition for the alert, enter 90 in the % field and then select 1.3 GB (Min Value). Select < (Less than) from the comparison menu.

6. In the Enable Action(s) field, specify 1 for the number of times the alert is issued, 15 for the timer period, and select minutes for the time period units. These values specify that the alert is issued one time every 15 minutes while the alert condition is met.

7. Click OK to define the alert.
Access Management

You can use SAS Environment Manager to manage access in the metadata authorization layer. The access control tasks that are provided by SAS Environment Manager include:

• application of ACTs to objects
• maintenance of access control templates (ACTs)
• application of explicit controls to objects
• management of repository-level controls

Over the lifecycle of SAS 9.4, functions will be added to extend SAS Environment Manager's capabilities as a centralized administration application for all SAS products. SAS Environment Manager is not currently a replacement for SAS Management Console, and no functionality has been removed from SAS Management Console.
To manage access to metadata objects in SAS Environment Manager, follow these steps:

1. Select the **Administration** page.
2. Right-click on an object in the **Folders** pane, and select **Open**. The tab corresponding to the object that you selected is displayed. For example, if you right-clicked **My Folder**, the **My Folder** tab will be displayed.
3. Select the **Authorization** tab. A window similar to the following is displayed:

![Authorization Tab](image_url)

---

**Creating an ACT**

**Why Create Custom ACTs?**

Several predefined ACTs are provided. To further centralize access management, create an ACT for each access pattern that you use repeatedly. Here are some common patterns and tips:

- It is often useful to create ACTs to manage Read access for different business units.
- It is often useful to create an ACT that manages Write access for a functional group that includes users from multiple business units.
- You do not have to capture all of an object's protections in one ACT. You can use combinations of ACTs, explicit controls, and inherited settings to define access to an object.

**Instructions**

1. Access the **Administration** page.
2. From the **Folders** pane, navigate to **SAS Folders** \rightarrow **System** \rightarrow **Security** \rightarrow **Access Control Templates**.

4. In the New Access Control Template window, enter a name and description for the ACT. Click Save. The new ACT opens in its own tab.

5. On the Authorization ➜ ACT Pattern tab:
   a. Click . In the Add Identities window, select users and groups that will have explicit settings in the pattern. Click OK.
   b. On the ACT Pattern tab, click cells and make selections from the drop-down list to define the ACT’s pattern.

6. On the ACT's Authorization tabs, protect the new ACT. For example, one approach is to add an explicit denial of WriteMetadata for PUBLIC and an offsetting explicit grant of WriteMetadata for SAS Administrators.

   Note: It is important to prevent regular users from modifying or removing an ACT.

7. In the toolbar at the top of the tab, click to save the new ACT.

8. To use the ACT, apply it to one or more objects.

   Note: The applied ACT contributes its pattern of access controls to the object's protections. The object can also have explicit controls and other applied ACTs (as well as inherited settings).

9. If necessary, adjust the ACT's pattern. The advantage of using an ACT is that you can change the pattern without revisiting the objects to which the pattern is applied.

---

### Using an ACT

#### Why Use ACTs?

Use ACTs to avoid having to repeatedly add the same explicit controls for the same identities on multiple objects. When you apply an ACT to an object, the pattern settings in an ACT are added to the direct controls of an object.

Tip Settings in the pattern of an ACT affect access to all of the objects to which the ACT is applied. Settings on the Authorization tab for an ACT affect who can access that ACT.

#### Instructions

1. Open the object to which you will apply the ACT. On the Authorization ➜ Apply ACTs tab for an object, select the check box for the appropriate ACT.

   Tip The repository ACT (which is usually named Default ACT) should not be directly applied to any object. Instead, the repository ACT participates through inheritance, serving as an access control parent of last resort.

2. On the Authorization ➜ Basic tab for an object, notice that the identities that participate in the pattern of an ACT are listed. Verify that the revised settings are as you expect.

3. In the toolbar at the top of the tab, click .
Updating an ACT

**CAUTION:**

One ACT can protect thousands of objects. Changes that you make to an ACT’s pattern affect every object that ACT is applied to.

To update an ACT, follow these steps:

**Locating an ACT**

1. Access the Administration page.
2. From the Folders pane, navigate to SAS Folders ➔ System ➔ Security ➔ Access Control Templates.
   
   *Note:* To locate ACTs that are in custom repositories, your navigation path will vary slightly. For example: SAS Folders ➔ custom-repository ➔ System ➔ Security ➔ Access Control Templates.
3. Find the ACT that you want to update.

**Modifying an ACT**

4. Right-click the ACT and select Open. A window similar to the following is displayed:

5. To understand the potential impact of your intended changes, examine the ACT’s Usage tab.
6. To modify the ACT’s pattern:
   a. Adjust settings on the Basic tab.
   b. In the toolbar at the top of the tab, click .
3. (Optional) Navigate to an object that uses the ACT and verify that the revised settings are as you expect.
Reviewing or Adjusting Repository-Level Controls

Which ACT is the Repository ACT?

If your site has multiple metadata repositories, you have multiple repository ACTs. Each repository has its own repository ACT, which is usually named Default ACT.

As an alternative to opening each ACT to determine which repository it belongs to, navigate to the ACT from within the Folders view.

- ACTs for the foundation repository are located in the SAS Folders ⇒ System ⇒ Security ⇒ Access Control Templates folder.
- ACTs for a custom repository are located in the SAS Folders ⇒ custom-repository ⇒ System ⇒ Security ⇒ Access Control Templates folder.

Note: The repository ACT indicator is located at the bottom of the access-control-template ⇒ Authorization ⇒ Usage tab.

Why Adjust the Repository-Level Controls?

CAUTION:

Altering the repository-level controls for service identities can prevent necessary access. We recommend that you do not change these settings.

Here are some key points about working with repository-level controls for a foundation repository:

- If you want some or all users to have default Read access to all data, grant the Read permission at the repository level.
- If you want to experiment with changing repository-level access, we recommend that you create a new ACT and designate that ACT as the repository ACT (instead of modifying the original repository ACT).
- All users need ReadMetadata and WriteMetadata access to the foundation repository. It is appropriate for the SASUSERS group to be granted these permissions in the pattern of the repository ACT.

Adding an Explicit Grant or Denial

1. Open the object that you want to protect or make available.

2. On the Authorization ⇒ Basic tab, locate the user or group that you want to assign an explicit control to. If the user or group is not listed, click + to open the Add Identities window.
Note: An explicit grant of the ReadMetadata permission is automatically set for each identity that you add.

3. Click a cell and make a selection from the drop-down list.

Note: If the selected identity is unrestricted, all permissions are granted and you cannot make changes.

Note: When you click outside the cell, the yellow diamond that indicates an explicit control is displayed in the cell that you updated.

4. If you changed the access for a group, review the impact on all of the listed identities.

Note: This is important because controls that you add for a group can affect access for all members of that group. For example, an explicit denial that you add for the PUBLIC group blocks access for all restricted users, unless there are also explicit (or direct ACT) grants. You must offset a broad explicit denial with explicit (or direct ACT) grants for any restricted identities whose access you want to preserve.

5. In the toolbar at the top of the tab, click 📐.  

**T I P** It is easy to add explicit grants and denials on each object that you want to protect or make available. However, adding a large number of individual access controls can make access control management unnecessarily cumbersome.

---

**Adding a Row-Level Permission Condition**

**What is a Permission Condition?**

A permission condition limits an explicit grant of the Read permission so that different users access different subsets of data.

**Instructions**

To limit Read access to rows in a LASR table:

1. Access the Authorization ➔ Basic tab for a LASR table.

2. In the Read column, click the cell for the identity that you want to assign the condition to.

   Note: If the identity is not already listed, click at the right edge of the table to add the identity.

3. From the cell’s drop-down list, select Conditional grant.

   Note: If Conditional grant is already selected, a condition already exists (and selecting Conditional grant enables you to view or update the condition).

4. In the New Permission Condition window, create a condition that specifies which rows the identity can see.

5. Click OK. Notice that the cell contains the conditional grant icon 🏷️ with an explicit control indicator ✠️.
Providing Fine-Grained Access Using Permission Conditions

Overview

Starting with the first maintenance release for SAS 9.4, you can use permission conditions to give users access to some but not all of the data within a physical table and parent library. For more information about fine-grained controls for data, see SAS Intelligence Platform: Security Administration Guide.

Use the following approach:

1. If the physical table and its parent library are not already bound to metadata, bind them.
2. Set metadata-layer permissions to control who can access each table.
3. Use SAS Environment Manager to specify permission conditions.

Instructions

1. Access the Authorization ⇒ Basic tab for the secured table object that corresponds to the metadata-bound library whose data sets you want to protect.

2. In the Select column, click the cell for the identity whose access you want to limit.
   
   Note: If the identity is not already listed, click + at the right edge of the table to add the identity.

3. From the cell’s drop-down list, select Conditional grant to add an explicit grant of the Select permission for the selected identity.
   
   Note: If Conditional grant is already selected, a condition already exists (and selecting Conditional grant enables you to view or update the condition).

4. In the New Permission Condition window, enter the WHERE clause for an SQL query that filters the data as appropriate for the selected identity. Do not include the WHERE key word in your entry.

TIP: To make dynamic, per-person access distinctions, you can use identity-driven properties as the values against which target data values are compared. Use the following syntax when specifying one of these properties:

   SUB::property-name (for example, SUB::SAS.Userid). For a list of available identity-driven properties, see SAS Intelligence Platform: Security Administration Guide.

CAUTION: The syntax that you enter and save in the New Permission Condition window is not checked for validity. Make sure that the syntax that you have entered is correct.
5. Click **OK**. Notice that the cell contains the conditional grant icon with an explicit control indicator.

6. In the toolbar at the top of the tab, click.
Chapter 8
Controlling Access to SAS Environment Manager

Controlling Access to SAS Environment Manager

About Native Roles and Users
SAS Environment Manager controls access and permissions within the application with its own registry of users and its own system of roles and permissions. In order to distinguish between the SAS Environment Manager access features and those in SAS metadata, this document and the SAS Environment Manager online Help refers to features internal to SAS Environment Manager as native features (such as native users or native roles). However, the SAS Environment Manager interface does not use the native terminology.

Although native user definitions are internal to SAS Environment Manager, they are mapped to user definitions created in SAS metadata. Native users are created by first creating the user definition in metadata and then synchronizing the user information with SAS Environment Manager. You cannot create native user definitions in SAS Environment Manager directly.

Native roles enable you to grant capabilities and permissions for actions in SAS Environment Manager to selected users. For example, an administrator role could be granted full permissions for all resource types and the ability to acknowledge and fix alerts, and a guest role could be denied the ability to fix or acknowledge alerts and have only Read permission for resources. Assigning a native role to a native user determines the actions that the user can perform in SAS Environment Manager.

Each native role also has its own unique Dashboard page, which you can customize to match the native role’s tasks. Each user has access to their own personal Dashboard page and the Dashboard pages of all native roles of which they are a member.
SAS Environment Manager and SAS Metadata Users

Users in SAS Environment Manager are mapped to users created in SAS metadata. During installation, three user groups are created in SAS metadata to contain SAS Environment Manager users. Users and subgroups that are members of these groups are mapped to user definitions in SAS Environment Manager with corresponding roles. The user groups and their corresponding roles are as follows:

<table>
<thead>
<tr>
<th>Group name in SAS metadata</th>
<th>Role in SAS Environment Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS_EV_Super_User</td>
<td>Super User role</td>
</tr>
<tr>
<td>SAS_EV_Guest</td>
<td>Guest role</td>
</tr>
<tr>
<td>SAS_EV_AppServer_Tier</td>
<td>SAS App Tier role</td>
</tr>
</tbody>
</table>

For example, users that are members of the group SAS_EV_Guest in metadata are created as users in SAS Environment Manager and are assigned to the Guest role when the users are synchronized.

When you install SAS Environment Manager, all existing SAS Environment Manager user definitions are automatically added to the SAS_EV_Guest group in metadata. After the existing users have been added to the SAS_EV_Guest group, use SAS Management Console to modify the user definitions or assign the users to other SAS_EV groups in metadata.

After you have defined new users in SAS metadata, sign on to SAS Environment Manager, and select Manage ⇒ Synchronize Users. User definitions are created for all users that are defined in the three SAS_EV groups in metadata. Any SAS Environment Manager users that are not associated with user definitions in metadata are deleted.

If you sign on to SAS Environment Manager using a user ID that is defined in metadata, is a member of one of the SAS_EV groups, but is not defined in SAS Environment Manager, then a user definition is automatically created in SAS Environment Manager and assigned to the correct role.

The mapping between user information in metadata and in a SAS Environment Manager user definition is as follows:

<table>
<thead>
<tr>
<th>Metadata field</th>
<th>SAS Environment Manager field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>First Name and Last Name</td>
</tr>
<tr>
<td>Name</td>
<td>First Name if the Display Name is not specified</td>
</tr>
<tr>
<td>Account</td>
<td>Username</td>
</tr>
<tr>
<td>Email</td>
<td>Email</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone</td>
</tr>
</tbody>
</table>
To create a new SAS Environment Manager user, use an application such as SAS Management Console to define the user and assign it to the appropriate SAS_EV user group, and then select Manage ⇨ Synchronize Users to create the user in SAS Environment Manager and assign the user to the proper role.

The users in the SAS App Tier role are automatically granted access to the resources in these resource groups:

- SAS App Tier group
- SAS App Tier Server group
- SAS App Tier Services group

An internal account, sasevs (sasevs@saspw), is also created during installation. This account is assigned to the SAS_EV_Guest group. The account is used for communications between the SAS Environment Manager agent and server and enables plugins to access the SAS Metadata Server. The internal account sasadm@saspw is the default account for signing on to SAS Environment Manager.

The SAS Logon Manager is used to control the process of logging on to SAS Environment Manager. The application uses the same authentication process and authentication provider as the other SAS web applications.

**Updating Passwords for SAS Environment Manager Metadata Identities**

To update the password for the saseve@saspw account, follow these steps:

1. Stop all SAS Environment Manager agents on the system.
2. On the middle-tier machine, use the SAS Deployment Manager to change the password for the sasevs account.
3. Use the SAS Deployment Manager to update the sasevs password on the machines in the other tiers in the system.
4. Restart the SAS Environment Manager agents.

**Creating a Native Role**

To create a native role, follow these steps:

1. On the Manage page, select New Role.
2. On the New Role page, specify a name for the role and select the native permissions and capabilities for each resource type. If you grant the Read Only permission for a resource type, you can also select the native capabilities for the resource type. For all other permissions, the capabilities are automatically selected or disabled and cannot be changed.
3. Use these guidelines to determine the native permissions to set:
   - Adding resource to the inventory and creating alert definitions
     Select Full or Read / Write permissions. Users can also respond to alerts and control resources.
   - Monitoring resources, responding to alerts, controlling resources
     Select the Read Only permission and grant the capability to acknowledge and fix alerts and to control resources. Users can respond to alerts and control resources but cannot create or modify alerts or resources.
Monitoring resources
Select the Read Only permission, but do not grant capabilities for alerts resource control. Users can view and monitor only resources.

4. When you click OK, the role and associated Dashboard page are created, and the Role Properties page is displayed. Use this page to select native users and resource groups that should be associated with the role and to create an alert calendar.

5. To create an alert calendar, select the days and times during which the roles’ users will be notified of alerts. Make sure that at least one role is available during every time period.

Creating SAS Middle-Tier Administrator IDs

Administrators for SAS middle-tier servers must be defined in SAS metadata as well as in SAS Environment Manager. To create a middle-tier administrator user ID, follow these steps:

1. Use the User Manager plug-in in SAS Management Console to create a user definition for a middle-tier administrator.

2. Assign the user to the SAS_EV_AppServer_Tier user group. This group is created during the installation and configuration process.

3. Sign in to SAS Environment Manager using the sasevs@saspw credentials, which is the default administrative identity.

4. Click Manage \( \Rightarrow \) Synchronize Users to synchronize the SAS Environment Manager users with the SAS metadata users.

5. Click List Users to view the list of all users.

6. Locate the entry in the user table for the new user and click the user name entry to display the Properties page.

7. In the Roles Assigned To section, verify that the user is assigned to the SAS App Tier role.
Chapter 9

Setting up SAS Environment Manager — Examples

Configuring HTTP Components and Applications

Creating a Platform Service
Configuring a Platform Service for SAS Stored Process Web Application
Configuring a Platform Service for SAS Content Server
Configuring a Platform Service for SAS Web Report Studio
Configuring a Platform Service for SAS BI Dashboard
Configuring a Platform Service for SAS Help Viewer for Middle-Tier Applications
Configuring a Platform Service for SAS Information Delivery Portal
Configuring a Platform Service for SAS Web Administration Console

Summary Portlet Examples
Adding Summary Portlets
Example: Adding a Summary Portlet for SAS Servers That Can Be Spawned
Example: Adding a Platform Availability Summary Portlet

Metric Viewer Portlet Examples
Adding Metric Viewer Portlets
Example: Adding a SASWork Disk Space Metric Viewer
Example: Adding a WebApp Login Response Time Metric Viewer
Example: Adding a PostgreSQL Data Volume Metric Viewer
Example: Adding a tc Runtime Manager Active Sessions Metric Viewer

Metric Chart Examples
Adding a Saved Chart Portlet
Creating a Free Memory Chart
Creating a Number of Spawned Servers Chart
Creating a Metadata Users Chart
Adding a Saved Charts Portlet

Configuring HTTP Components and Applications

Creating a Platform Service

You must create several platform services in order to monitor access to SAS web applications. This is the basic procedure for creating and configuring a platform service.

1. Select Resources → Browse
2. Select Platforms.
3. Select the entry in the **Platform** table for your server.
4. On the Details page for the selected platform, select **Tools Menu \( \Rightarrow \) New Platform Service**. The New Service window appears.
5. Specify a name for the service and select HTTP in the **Service Type** field. Click **OK**.

6. The **Details** page for the new service appears. A message is displayed that the resource has not been configured. Click the **Configuration Properties** link to configure the service.
7. On the Configuration Properties page, specify the information required for the service. Values for each service are provided in the following sections.

8. Click **OK** to complete the configuration process.

**Configuring a Platform Service for SAS Stored Process Web Application**

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.
Configuring a Platform Service for SAS Content Server

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

**port**
- specify 7980

**path**
- specify /SASContentServer

**user**
- specify sasadm@saspw

**pass**
- specify the password for the user

**method**
- select GET

**follow**
- select this check box

**pattern**
- specify SASContentServer

**service.log.track.enable**
- select this check box

**service.log.track.level**
- select Info

**service.log.track.include**
- specify Content
Configuring a Platform Service for SAS Web Report Studio

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

**port**
- specify 7980

**path**
- specify /SASWebReportStudio

**user**
- specify a username (such as sasdemo)

**pass**
- specify the password for the user

**method**
- select GET

**follow**
- select this check box

**pattern**
- specify SASWebReportStudio

service.log.track.enable
- select this check box

service.log.track.level
- select Info

service.log.track.include
- specify Report

Configuring a Platform Service for SAS BI Dashboard

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

**port**
- specify 7980

**path**
- specify /SASBIDashboard

**user**
- specify a username (such as sasdemo)

**pass**
- specify the password for the user

**method**
- select GET

**follow**
- select this check box

**pattern**
- specify SASBIDashboard
Configuring a Platform Service for SAS Help Viewer for Middle-Tier Applications

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

- **port**
  - specify 7980

- **path**
  - specify /SASWebDoc

- **method**
  - select GET

- **follow**
  - select this check box

- **pattern**
  - specify SASWebDoc

- **service.log.track.enable**
  - select this check box

- **service.log.track.level**
  - select Info

- **service.log.track.include**
  - specify Documentation

Configuring a Platform Service for SAS Information Delivery Portal

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

- **port**
  - specify 7980

- **path**
  - specify /SASPortal

- **user**
  - specify a username (such as sasdemo)

- **pass**
  - specify the password for the user

- **method**
  - select GET

- **follow**
  - select this check box
Configuring a Platform Service for SAS Web Administration Console

Follow the steps in “Creating a Platform Service” on page 53 to create the service. Specify the following information on the Configuration Properties page.

**port**
- specify 7980

**path**
- specify /SASAdmin

**user**
- specify sasadm@saspw

**pass**
- specify the password for the user

**method**
- select GET

**follow**
- select this check box

**pattern**
- specify SASAdmin

**service.log.track.enable**
- select this check box

**service.log.track.level**
- select Info

**service.log.track.include**
- specify Administration

---

Summary Portlet Examples

**Adding Summary Portlets**

Here are the basic steps for adding a summary portlet to your Dashboard page.

1. On the left side of the Dashboard page, select **Availability Summary** in the **Add Content to this column** field and click the Add icon. A blank **Availability Summary** portlet is added to your Dashboard.
2. Click the Configuration icon to display the Dashboard Settings page for the portlet.

3. Specify a name for the portlet in the Description field. This name will appear in the header for the portlet, after the portlet type.

4. In the Selected Resources area, click Add to List to display the Add/Remove Resources page.

5. To display the resources that you want to use for the summary, specify values in the View and Filter By Name fields. If you specify a value in the Filter By Name field, click to filter the table contents.

6. In the Resources table, select the check boxes for the resources that you want to use in the summary. Click to move the resources to the Add Resources list.

7. After you select the resources that you want to use in the Add/Remove Resources window, click OK to return to the Availability Summary window. Click OK to create the portlet and add it to your Dashboard page.
Example: Adding a Summary Portlet for SAS Servers That Can Be Spawned

This example explains how to add a portlet to your Dashboard page that monitors the availability of SAS Workspace Servers that are running under a SAS Object Spawner.

1. Follow the basic procedure for creating an availability summary portlet in “Adding Summary Portlets” on page 58. Follow the basic procedure for creating an availability.

2. On the Add/Remove Resources window, in the View field, select Services. Logical SAS servers are listed as services in SAS Environment Manager.

3. In the Filter By Name field, enter spawner and click [ ]. The Resources list displays the services running under the SAS Object Spawner.

4. Select the resources Workspace Server and Pooled Workspace Server and move them to the Add Resources table.
5. Finish the procedure for creating the portlet. The portlet displays the availability information for the servers that can be spawned.

Example: Adding a Platform Availability Summary Portlet

To add a portlet to monitor the availability of all of the platforms in the environment, follow these steps:

1. Follow the basic procedure for creating an availability summary portlet in “Adding Summary Portlets” on page 58.

2. In the Add/Remove Resources page, select Platforms in the View field and select the check box beside the Name column in the Resources table. This selects all of the listed platforms.
3. Complete portlet creation process to add the portlet to your dashboard.

---

**Metric Viewer Portlet Examples**

**Adding Metric Viewer Portlets**

Here are the basic steps for adding a metric viewer portlet to your Dashboard page.

1. On the right side of the Dashboard page, select Metric Viewer in the Add Content to this column field and click the Add icon. A blank Metric Viewer portlet is added to your Dashboard.

2. Click the Configuration icon to display the Dashboard Settings page for the portlet.
3. On the Dashboard Settings page, specify a name for the portlet in the Description field. Select the type of resource that you want to monitor in the Resource Type field and the information that you want to display in the Metric field. The values available in the Metric field change depending on what you select in the Resource Type field.

4. In the Selected Resources area, click Add to List to display the Add/Remove Resources page.

5. To display the resources that you want to use for the metric, specify values in the View and Filter By Name fields. If you specify a value in the Filter By Name field, click ▼ to filter the table contents.

6. In the Resources table, select the check boxes for the resources that you want to use in the metric. Click ▶ to move the resources to the Add Resources list.

7. After you select the resources that you want to use in the Add/Remove Resources window, click OK to return to the Dashboard Settings page. Click OK to create the portlet and add it to your Dashboard page.

Example: Adding a SASWork Disk Space Metric Viewer

To add a portlet for viewing the usage of the SASWork directory, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 62.

2. On the Dashboard Settings page, specify the following information:

   Description
   specify a name for the portlet

   Resource Type
   select SAS Home Directory 9.4 SAS Directory

   Metric
   select Use Percent
3. In the Add Resources window, select all resources in the Resources table, click the Add icon to move them to the Add Resources table, and click OK.

4. Complete the procedure to add the portlet to your Dashboard page.

**Example: Adding a WebApp Login Response Time Metric Viewer**

To add a portlet for viewing the response time for all web applications, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 62.

2. On the Dashboard Settings page, specify the following information:

   - **Description**: specify a name for the portlet
   - **Resource Type**: select HTTP
   - **Metric**: select Response Time

3. In the Add Resources window, select all resources in the Resources table, click the Add icon to move them to the Add Resources table, and click OK.

4. Complete the procedure to add the portlet to your Dashboard page.
Example: Adding a PostgreSQL Data Volume Metric Viewer

To add a portlet for viewing the volume of data in all PostgreSQL databases, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 62.

2. On the Dashboard Settings page, specify the following information:
   - **Description**: specify a name for the portlet
   - **Resource Type**: select PostgreSQL 9.x Database
   - **Metric**: select Data Space Used

3. In the Add Resources window, select all resources in the Resources table, click the Add icon to move them to the Add Resources table, and click OK.

4. Complete the procedure to add the portlet to your Dashboard page.

Example: Adding a tc Runtime Manager Active Sessions Metric Viewer

To add a portlet for viewing the number of active sessions for all web applications, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 62.

2. On the Dashboard Settings page, specify the following information:
   - **Description**: specify a name for the portlet
   - **Resource Type**: select SpringSource tc Runtime 7.0 Manager
   - **Metric**: select Active Sessions
3. On the Add/Remove Resources page, in the View field, select Servers. In the Resources table, select these servers:

- `<server_name>` tc Runtime SASServer1_1/SASWebReportStudio localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASAdmin localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASContentServer localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASBIDashboard localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASWebDoc localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASPortal localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASLogon localhost Manager
- `<server_name>` tc Runtime SASServer1_1/SASStoredProcess localhost Manager

Some of these servers might be on the second page of the list (click the page number at the bottom of the list to navigate between pages). Click the Add icon to move the selected servers on one page before moving to another page.

4. Complete the procedure to add the portlet to your Dashboard page.

---

**Metric Chart Examples**

**Adding a Saved Chart Portlet**

The Saved Chart portlet displays a rotation of all of the resource metric charts that you have saved. The process of creating this type of portlet consists of navigating to the resources that you want to chart, finding the metric charts that you want to display, and saving them to your dashboard. When you create the portlet, all of your saved charts automatically appear. Here are the basic steps for adding a metric viewer portlet to your Dashboard page.

1. On the right side of the Dashboard page, select Metric Viewer in the Add Content to this column field and click the Add icon. A blank Metric Viewer portlet is added to your Dashboard.
2. Click the Configuration icon to display the Dashboard Settings page for the portlet.

3. On the Dashboard Settings page, specify a name for the portlet in the **Description** field. Select the type of resource that you want to monitor in the **Resource Type** field and the information that you want to display in the **Metric** field. The values available in the **Metric** field change depending on what you select in the **Resource Type** field.

4. In the **Selected Resources** area, click **Add to List** to display the Add/Remove Resources page.

5. To display the resources that you want to use for the metric, specify values in the **View** and **Filter By Name** fields. If you specify a value in the **Filter By Name** field, click **Search** to filter the table contents.

6. In the **Resources** table, select the check boxes for the resources that you want to use in the metric. Click **Add** to move the resources to the **Add Resources** list.

7. After you select the resources that you want to use in the Add/Remove Resources window, click **OK** to return to the Dashboard Settings page. Click **OK** to create the portlet and add it to your Dashboard page.
Creating a Free Memory Chart

To create a chart of the free memory on a server and save that chart to your dashboard, follow these steps.

1. On the SAS Environment Manager menu bar, select **Resources ➔ Browse**.
2. On the Resources page, select **Platforms**.
3. In the table of resources, click on the name of your server to display the resource detail page.
4. On the resource detail page, one of the displayed metric charts is **Free Memory**. Click on the name of the chart to display the Metric Chart page.

5. On the Metric Chart page, select **Save Chart to Dashboards**.

6. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click **Add** to save the chart.
Creating a Number of Spawned Servers Chart

To create a chart of the current number of spawned servers and save that chart to your dashboard, follow these steps.

1. On the SAS Environment Manager menu bar, select Resources Browse.

2. On the Resources page, in the All Server Types field, select SAS Object Spawner 9.4 and then click on the arrow at the right of the filter fields.

3. In the table of resources, click on the name of the object spawner to display the resource detail page.

4. On the resource detail page, one of the displayed metric charts is Current Servers. Click on the name of the chart to display the Metric Chart page.
5. On the Metric Chart page, select **Save Chart to Dashboards**.

6. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click **Add** to save the chart.

---

### Creating a Metadata Users Chart

To create a chart of the current number of users per minute of the SAS Metadata Server and save that chart to your dashboard, follow these steps.

1. On the SAS Environment Manager menu bar, select **Resources** ➜ **Browse**.

2. On the Resources page, in the **All Server Types** field, select **SAS Metadata Server 9.4** and then click on the arrow at the right of the filter fields.

3. In the table of resources, click on the name of the metadata server to display the resource detail page.

4. On the left side of the resource detail page, select All Metrics from the menu.
5. In the table of metrics, find **Total Clients per Minute** and position your mouse cursor over the information icon 📊. The metric information tooltip appears.

6. On the tooltip, select **View Full Chart**. The Metric Chart page appears.

7. On the Metric Chart page, select **Save Chart to Dashboards**.

8. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click **Add** to save the chart.

**Adding a Saved Charts Portlet**

Follow these steps to add a portlet that displays the charts that you have saved.

1. Click **Dashboard** on the menu bar.

2. On the left side of the Dashboard page, select **Saved Charts** in the **Add Content to this column** field and click the Add icon 📂.

A **Saved Charts** portlet is added to your Dashboard and automatically displays a slideshow of the charts that you previously saved.
3. To change how long each chart is displayed or the time period displayed on the chart, click the Configuration icon.

- **Chart Rotation**: Check to enable chart rotation.
- **Rotation Interval**: Choose "10 second(s)".
- **Time Range**: Set to "1 day(s)".

[Save] [Cancel]
Appendix 1
Troubleshooting

Resolving Problems with SAS Environment Manager .......................... 73
Resolving Problems with SAS Environment Manager Agents .......... 74
Resolving Problems with SAS Environment Manager Plugins .......... 76

Resolving Problems with SAS Environment Manager

Cannot Add Discovered Resources into Inventory

When you add auto-discovered resources into the inventory, you might see the following error message

Unable to import platform :
org.hyperic.hq.common.SystemException:
org.hibernate.ObjectNotFoundException:
No row the the given identifier exists: [org.hyperic.hq.autoinventory.Allp#10001]

Purge the AIQ data in the SAS Environment Monitor database. Follow these steps:

1. Select Administration ⇒ HQ Health ⇒ Database tab
2. Select Purge AIQ Data from the Action menu.

These messages appear:
- DELETE FROM EAM_AIQ_IP: 0 rows
- DELETE FROM EAM_AIQ_SERVICE: 0 rows
- DELETE FROM EAM_AIQ_SERVER: 0 rows
- DELETE FROM EAM_AIQPLATFORM: 0 rows

3. Restart the agents.

Resource in Availability Portlet with No Availability Information

If you add a resource that has been discovered but does not have any availability information to an Availability Summary portlet, the portlet will never display any information for the resource. The server log contains this information:

1. On the Resources tab, delete the platform that contains the resource.
2. Stop the agent.

3. Delete the tokendata, keystore, and keyvals files from the directory `<SAS-configuration-directory>/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/data`.

4. Issue the command `hq-agnet.bat/sh restart` from the command console.

**New Folders Are Not Displayed**

If you are using Microsoft Internet Explorer, newly created folders might not show up in the folder tree.

To ensure that new folders appear, from the Internet Explorer menu, select **Tools ⇒ F12 Developer Tools**. From the Internet Explorer Developer Tools menu, select **Cache ⇒ Always refresh from server**.

**Validate Result Dialog Box Appears When Renaming a Folder**

If you cause an error when you rename a folder (because, for example, you used invalid characters in the name or specified a blank name), the folder is not saved and the Validate Result dialog box appears.

To view details about the error, click the text **Basic Properties page failed** in the dialog box.

---

**Resolving Problems with SAS Environment Manager Agents**

**Agent Fails to Start**

When you try to configure the SAS Environment Manager Agent, it does not start and you receive the error message *No token file found, waiting for Agent to initialize*

1. Stop the SAS Environment Manager agent.

2. Verify that the agent wrapper processes and the agent Java processes have stopped.

3. On the W6X platform, verify that the directory `%SystemRoot%\TEMP` exists. Remove the file `%SystemRoot%\TEMP\agent.encrypt.lock`.

   On all other UNIX platforms, search for the `java.io.tmpdir` environment variable in the agent wrapper process and the agent Java process. By default, the value of the variable will be set to the `\tmp` or `\var\tmp` directory. If the variable exists, remove the file `agent.encrypt.lock` under the specified directory.

**Agent Receives the Error “OutOfMemory GC Overhead Limit Exceeded”**

The `agent.log` file contains the message *java.lang.OutOfMemoryError: GC overhead limit exceeded*

Include these JVM options in the startup script for each agent:

```-XX:NewRatio=8
-XX:+CMSClassUnloadingEnabled```
Modify the file `SAS-configuration_directory/LevX/Web/SASEnvironmentManager/agent-5.8.0-EE/bundles/agent-5.8.0/bin/hq-agent.sh` or `hq-agent.bat` and add these JVM options to the `CLIENT_CMD` variable:

```
CLIENT_CMD="${HQ_JAVA} \n-D${AGENT_INSTALL_HOME_PROP}=${AGENT_INSTALL_HOME} \n-D${AGENT_BUNDLE_HOME_PROP}=${AGENT_BUNDLE_HOME} \n-XX:NewRatio=8 \n-XX:+CMSClassUnloadingEnabled \n-XX:+UseTLAB \n-XX:+UseCompressedOops \n-cp ${CLIENT_CLASSPATH} ${CLIENT_CLASS}"
```

**EncryptionOperationNotPossibleException Error Message**

After the agent successfully starts, some agent properties might get encrypted. If the agent cannot read the `agent.scu` file (which contains the encryption keys), it cannot decrypt the properties. The agent will not start and the `agent.log` or the `wrapper.log` file contains the error `org.jasypt.exceptions.EncryptionOperationNotPossibleException`.

1. Stop the SAS Environment Manager agent.
2. In the directory `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE`, delete the `/data` directory.
3. In the directory `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/conf`, delete the `agent.scu` file.
4. Modify the encrypted property to a plain text value. In the file `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/agent.properties`, set the property `agent.setup.camPword` to a plain text value (if it is encrypted, it will appear as ENC(XXXXXXXXXX)).
5. In the file `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/auto-approve.properties`, change all values to True.
6. Restart the agent.

**Cannot Stop EAgent Service Using Windows Services**

On Windows, if you use Windows Services to stop the Hyperic Agent service, you will receive the error message `Windows could not stop the SAS[SAS94-Lev1] SAS Environment Manager Agent on Local Computer`. Clicking OK in the error message dialog box seems to stop the service, but the System Event Log contains the error `The SAS [SAS94-Lev1] SAS Environment Manager Agent service terminated with service-specific error Incorrect function.`

Use the command line, rather than Windows Services, to stop the agent. The command to stop the agent is `<sas_configuration_directory>/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.bat stop.`
Resolving Problems with SAS Environment Manager Plugins

**PostgreSQL Resources Not Configured Properly**

After a PostgreSQL server is added into inventory, the Dashboard page indicates that the resource is not configured properly.

On the Configuration Properties page for the server, specify this information:

- **postgresql.user**: specify the Web Infrastructure Platform Data Server database user name. The default value is dbmsowner.
- **postgresql.pass**: specify the password for the user name.
- **postgresql.program**: specify the path to the postgres.bat or postgres.sh file (on UNIX); or postgres.exe or postgres.bat (on Windows). On UNIX, the path is `/opt/sas/leve1/SASWebInfrastructurePlatformDataServer/webinfdsvrc.sh`. On W6X, the path is `<SAS_Configuration_Directory>\Leve1\SASWebInfrastructurePlatformDataServer\webinfdsvrc.bat`.

**Tomcat Resources Not Configured Properly**

On the AIX platform, the Apache Tomcat 6.0 server Resource page displays the error: *This resource is turned off or has not been configured properly. The problem is: Invalid configuration: Error contacting resource: Can't connect to MBeanServer url.*

1. Open the file `SAS_configuration_directory/Leve1/Web/SASEnvironmentManager/server-5.8.0-EE/hq-engine/hq-server/conf/hq-catalina.properties` and find the `jmx.url` port number. The default value is 1099.

2. On the Configuration Properties page for the server, specify the following property:

   ```
   jmx.url
   service:jmx:rmi:///jndi/rmi://localhost:port_number
   ```

**Cannot Discover tcServer Instances**

On the H6I platform, no tcServer instances can be discovered.

HPUX has a limit of 1020 characters on command line queries. The parameters that the tcServer plugin uses to identify the tcServer process are not seen by the agent because they fall after the 1020 character limit has been reached. Edit the startup script so that the parameters that the plugin needs are seen before the 1020 character limit.

Edit the catalina.sh script. Change this section of the script:

```bash
eval "$_RUNJAVA" "$_LOGGING_CONFIG" $JAVA_OPTS $CATALINA_OPTS \
-Djava.endorsed.dirs="$JAVA_ENDORSED_DIRS" -classpath "$CLASSPATH" \
-Dcatalina.base="$CATALINA_BASE" \
-Dcatalina.home="$CATALINA_HOME"
```
Change the script to this:

```bash
eval "$_RUNJAVA" "$LOGGING_CONFIG" \
-Dcatalina.base="$CATALINA_BASE" \
-Dcatalina.home="$CATALINA_HOME" \
$JAVA_OPTS \n$CATALINA_OPTS \
-Djava.endorsed.dirs="$JAVA_ENDORSED_DIRS" -classpath "$CLASSPATH" \n-Djava.io.tmpdir="$CATALINA_TMPDIR" \
org.apache.catalina.startup.Bootstrap "$@" start \n>> "$CATALINA_OUT" 2>&1 "&"
```

SAS Environment Manager Agent Will Not Start

Cannot start the SAS Environment Manager Agent by using the start script $SAS-configuration _directory/LevX/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.sh start.

The console displays this message:

```
Starting HQ Agent......Removed stale pid file: /local/install/cfgsas1/config/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/wrapper/sbin/../../wrapper/hq-agent.pid
WARNING: HQ Agent may have failed to start.
```

Use the unset command to remove the COLUMNS environment variable.
## Index

| A | access permissions 51  
  See also roles  
  creating middle-tier administrator IDs 52  
  access to data  
  fine-grained, using permission conditions 47  
  Active MQ 26  
  administrative tasks 12  
  administrator IDs, SAS middle tier 52  
  agents 2  
  Alert Center 10, 33  
  alerts  
  default definitions for 13  
  defining 34  
  examples of defining 37  
  monitoring with Alert Center 10, 33  
  responding with control actions 30  
  Analyze pages 10  
  Apache Tomcat 25  
  applications 28  
  authentication 13, 51  
  authorization 13, 51  
  Auto-Discovery portlet 16  
  using 19  
  automatic discovery of resources 19  
  rediscovering resources 20  
  running an auto-discovery scan 20  
  availability of resources 24  
  Availability Summary portlet 16  
  configuration 13  
  escalation schemes 13, 36  
  manually configuring a service 21  
  of resources for data collection 20  
  plugins 13  
  control actions 29  
  in response to an alert 30  
  scheduling 29  
  Control Actions portlet 16  
  customizing a Dashboard 17  
  
  D | Dashboard 8, 15  
  customizing 17  
  for native roles 49  
  database, SAS Environment Manager 2  
  discovering resources automatically  
  See automatic discovery of resources  
  
  E | escalation schemes, configuring 13, 36  
  events  
  monitoring with Event Center 12, 31  
  
  F | Favorite Resources portlet 16  
  fine-grained access to data  
  using permission conditions 47  
  
  G | Cisco IOS 4  
  clearing the auto-discovery queue 20  
  clusters  
  monitoring with Resources pages 9  
  compatible groups 27  
  components of SAS Environment Manager 2  
  GemFire Distributed System 4  
  Groovy Console 14  
  Group Alerts Summary portlet 16  
  groups  
  creating 28  
  monitoring with Resources pages 9  
  types 27  
  
  C | clusters  
  monitoring with Resources pages 9  
  compatible groups 27  
  components of SAS Environment Manager 2  
 
Index

H
HQ Agent 25
HQ Health 14
HQ Web Services API 14
Hyperic 1, 25

I
interface, SAS Environment Manager 7
Administration page 12
Alert Center 10
Analyze pages 10
Dashboard 8, 15
Event Center 12
Manage page 13
Operations Center 12
Resources pages 9

L
license usage 14

M
Manage page 13
management server 2
Map control 26
metadata
viewing in Administration page 12
Metric Viewer portlet 16
middle-tier administrator IDs 52
mixed groups 28
monitoring
availability of resources 24
default definitions for 13
licences 14
platforms, servers, and services 9
resource events and alerts 10, 31
using portlets on Dashboard 15
using Resources pages 23
using the Map control for servers and services 26

N
native roles
See roles
Network and Host Dependency Manager 14
Network Device 4
Network Host 4
network platforms 3

O
operating system platforms 3
Operations Center 12

P
permissions
See access permissions
platforms 3
monitoring with Resources pages 9
supported 4
plugins 3
configuring 13
portlets
adding to Dashboard 17
on Dashboard 15
PostgreSQL 26
controlling with control actions 29
Problem Resources portlet 17

R
Recent Alerts portlet 16
Recently Added portlet 16
resource groups 27
resource inventory model 3
platforms 3
servers 4
services 4
resources
automatically discovering 19
availability 24
configuring for data collection 20
controlling with control actions 29
manually adding to inventory 21
monitoring alerts 10, 33
monitoring events 12, 31
monitoring with Dashboard portlets 15
monitoring with Operations Center 12
monitoring with Resources pages 9, 23
organizing into groups 27
platforms 3
rediscovering 20
running an auto-discovery scan 20
servers 4
services 4
Resources pages 9, 20, 23
roles
creating native roles 51
Dashboard pages 49
managing with Manage page 13
native 49

S
SAS Application Server 3
SAS Application Server Tier platform 3
SAS Environment Manager
access permissions 51
components 2
configuring 13
interface 7
overview 1
SAS Environment Manager Agent server 25
SAS Environment Manager database 2
SAS Environment Manager server 25
SAS JMS Broker 26
SAS Logon Manager 51
SAS Metadata Server 3, 12
controlling with control actions 29
SAS Object Spawner
controlling with control actions 29
SAS OLAP Server 3
controlling with control actions 29
SAS Stored Process Server 3
SAS Web Application Server 26
controlling with control actions 29
SAS Web Infrastructure Platform Data Server 26
controlling with control actions 29
SAS Web Server 25
SAS Workspace Server 3
Saved Charts portlet 16
scanning for resources 20
scheduling control actions 29
Search Resources portlet 16
servers 4
Active MQ 26
Apache Tomcat 25
controlling with control actions 29
determining server names 25
HQ Agent 25
management server 2
managing settings with Manage page 13
manually adding to inventory 21
monitoring with Map control 26
monitoring with Resources pages 9
PostgreSQL 26, 29
SAS Application Server 3
SAS Environment Manager 25
SAS Environment Manager Agent 25
SAS JMS Broker 26
SAS Metadata Server 3, 12, 29
SAS OLAP Server 3, 29
SAS Stored Process Server 3
SAS Web Application Server 26, 29
SAS Web Infrastructure Platform Data Server 26, 29
SAS Web Server 25
SAS Workspace Server 3
SpringSource tc Runtime 26, 29
vFabric Web Server 25
services 4
controlling with control actions 29
manually adding to inventory 21
monitoring with Map control 26
monitoring with Resources pages 9
SpringSource tc Runtime 26
controlling with control actions 29
Summary Counts portlet 16
supported platforms 4

tc Server Command-line Interface 14

users
access permissions 51
creating middle-tier administrator IDs 52
managing with Manage page 13

vFabric Web Server 25
virtual platforms 3
VMware Hyperic 1, 25
VMware vsphere Host 4
VMware vsphere VM 4